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General Information

Introduction

Downloading 
outline fonts 
(Optional)

This booklet p rov ides inform ation  on 
PostScript driver selection and prin ting  
procedures with several of the most popular 
application programs. This information is also 
available in the reference manual for your 
application program. If your program is not 
covered in th is booklet, refer to your 
application program's reference manual for 
setup and printing information. You should 
thoroughly review your PacificPage P®£ 
User's Guide before attempting to print with 
PacificPage P*E.

W ith PacificPage P*E installed, you can 
supplement the fonts provided in the cartridge 
with outline fonts (soft fonts). The PacificPage 
£ •£  cartridge is compatible with Fontware™ 
Installation Kits and Fontware Typeface 
packages from Bitstream Inc. and with Adobe 
Type 1 fonts from  A dobe System s 
Incorporated. For instructions on installing 
Adobe Type 1 fonts, refer to your Adobe Type 
Library User's Manual or follow the brief 
instructions that may be provided in this book 
for your application software.

For instructions on installing Bitstream  
Fontw are for the follow ing softw are 
application programs, refer to the Bitstream 
Fontware Installation Kit Use/s Guide or to the 
appropriate software application section in this 
booklet: Ventura Publisher, WordPerfect 5.0 
and 5.1, Microsoft W ord 5.0, and Aldus 
PageMaker.

With additional printer memory installed, you 
can combine outline fonts with the fonts 
provided in the cartridge.
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The cartridge is able to recognize 4.5 MB of 
printer memory. This aUows you to use more 
downloadable outline fonts in conjunction 
w ith  the cartridge. The following table 
provides a general guideline to the quantity of 
downloadable outline fonts you can use. 
Ensure that the outhne fonts are instaUed as 
PostScript fonts, and that the printer selection 
matches the PostScript printer selected in your 
apphcation program.

Additional printer memory installed in 
Hewlett-Packard IIP, IID, III, IIID

Downloadable 
outline font quantity

With 1 MB of additional printer memory 0-1 outline fonts

With 2 MB of additional printer memory 3-4 outline fonts

With 3 MB of additional printer memory 10-14outlinefonts

With 4 MB of additional printer memory 8-11 outline fonts*

*The number of downloadable fonts you can use 
decreases when 4 megabytes or more of printer 
memory are installed because the double buffering 
feature of the cartridge becomes active and shares 
the additional memory. With less than 4 megabytes 
ofadditional memory, the double bufferingfeature 
is not active.

Caution
To allow downloading of Adobe Type 1 
printer fonts to a paraUel interface you 
must use the PCSEND Downloader file. 
This file may be obtained from Adobe 
Systems Incorporated. You can call 
Adobe at (415) 961-0911. If you attempt 
to download Adobe Type 1 printer fonts 
without this file, you will temporarily 
disable your printer.
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If you are dow nloading B itstream  
Fontware: It is recommended that you 
use the QEM font descriptions to obtain 
the highest quality output. To download 
printer fonts to a parallel interface using 
the Bitstream PS_DOWN program, you 
must have the PS_DOWN program file 
da ted  8 /2 3 /8 8 , ob tainab le  from  
Bitstream. This will not affect any of the 
in stru c tio n s  contained  in th is 
docum entation. The version dated  
6/12/89 will allow you to download 
fonts in serial mode only.

Note
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Ventura Publisher

Installing
driver

To use PacificPage  P*E w ith  V entura 
Publisher, you need to select a PostScript 
printer as your output device. Follow the steps 
below to select a PostScript printer and install 
the correct printer driver.

1. Insert Ventura's Applications Dis­
kette (#1) into drive A.

2. FromtheDOSprompttype 
A:VPPREP and press Enter.

3. Identify the drive where Ventura is lo­
cated.

4. At the "Are you installing this ver­
sion for the first time?" prompt, type 
N (no) and press Enter.

5. Insert Ventura's Utilities Diskette (#5) 
into drive A and press Enter. "Copy­
ing Utilities..." will be displayed on 
the screen.

6. Identify which graphics card and dis­
play you are using.

7. Identify which mouse and com­
munications port you are using.

8. At the '^Vhich printer do you have?" 
prompt, select F (PostScript printer) 
and press Enter.

9. Identify which port your printer is 
using.
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Printing a  
PostScript 
docum ent

10. At the "Do you want to add another 
printer?" prompt, type Y (yes).

11. At the "Which printer do you have?" 
prompt, select your HP LaserJet 300 
dpi printer. (You might want to 
select this printer option for PCL or 
non-PostScript mode printing).

12. Verify that the screen and printer 
choices are correct. Type Y (yes) and 
press Enter. Ventura will return you 
to the DOS prompt.

1. Enter the Ventura program and open 
the chapter you want to print.

2. From the Options menu select Set 
Printer Info...

3. Select PostScript.

4. Select the correct port (LPT1 or LPT2 
for parallel - COMl or COM2 for 
serial).

5. Select Load Different Width Table.

6. Select POSTSCPT.WID from the W en- 
turaV.WID directory. Select OK.

7. (POSTSCRIPT - Ultimate) should be 
displayed at the top of the SET 
PRINTER INFO menu. Select OK.

8. From the File menu select To Print...

9. Verify that (POSTSCRIPT - Ultimate) 
appears at the top of the PRDSTT DST- 
FORMATlON menu. SelectOK.
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Printing to a  
file

1. Enter the Ventura program and open 
the chapter you want to print to a file.

2. From the Options menu select Set 
Printer Info...

3. SelectPostScript.

4. At the port select option select
Filename.

5. Load the POST$CPT.WID width table 
if necessary.

6. (POSTSCRIPT - Ultimate) should be 
displayed at the top of the SET 
PRINTER INFO menu. Select OK.

7. From the File menu select TO PRINT...

8. Verify that (POSTSCRIPT - Ultimate) 
appears at the top of the PRINT IN­
FORMATION menu. Select OK. The 
ITEM SELECTOR menu will be dis­
played on the screen.

9. At the Directory: prompt, type the 
drive and directory where you will 
store the file.

10. At the Selection: prompt, type your 
filename. Ventura wiU automatically 
create a .C 0 0  extension on the file. 
Select OK.
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Copying  
PostScript 
files to your 
printer using 
a  serial 
interface

When copying Ventura PostScript files from 
DOS to your printer using a serial interface, 
you must first copy the DTR.TXT file to your 
printer. This file is contained on the Ventura 
Utilities disk in the POSTSCPT directory. To 
copy this file to your printer, insert the Ventura 
Utilities disk into drive A. Type:

COPY A:\POSTSCPT\DTR.TXT COMl: 
and press Enter.

Resetting
printer
tim eout
param eters

If the printer is taking a very long time to 
process data from a large or complex PostScript 
file, Ventura will automatically display a 
"Printer not Responding - retry or abort" 
message on the screen. If this happens often, 
you should  reset the p rin te r tim eout 
parameters using the DOS infinite retry mode 
command. Enter the foUowing command from 
the EKDS prompt.

For parallel interface:
MODE LPTl:,,Pandpress Enter.

For serial interface:
MODE COM 1:96,N,8,1 ,P and press Enter.
The "96" in the command above indicates the 
defavdt baud rate of 9600. If your computer 
and printer are configured for a different baud 
rate, replace "96" with that number.

Refer to your Ventura Publisher Reference 
Manual for information on creating spedal 
PostScript effects using Ventura.
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Special 
instructions 
forusers of 
Ventura 3.0 
GEM version

If you have the Ventura 3.0 GEM version, you 
may encounter the following message when 
you install Ventura and select a PostScript 
driver:

Error: The GEM PostScript pream ble 
is not ava ilab le  on your printer. 
P re-dow nload  the p ream b le  or 
include it with your print job. This 
print job has b een  aborted.

This message is not listed in the Ventura 
Publisher Reference Guide. This message is 
caused when the file PS2.PRE is either missing 
from the Ventura directory or has been 
corrupted. To restore the file, recopy the file 
PR2.PRE to the Ventura directory from the 
Supplemental Printer Driver Disk #11 of 
Ventura Publisher 3.0, or obtain the file from 
Xerox technical support.
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Installing 
outline fonts 
(optional)

If you need additional fonts to supplement the 
fonts provided in the cartridge, you may install 
downloadable outline fonts. To install Adobe 
Type 1 outline fonts for use with Ventura 
Publisher, refer to your Adobe Type Library 
User's Manual. To install Bitstream outline fonts 
for use with your PacificPage P*E cartridge, 
follow the steps below.

Note
This procedure assumes that you have 
previously installed Bitstream Fontware 
for use with Ventura Publisher.

1. At the DOS prompt, enter your 
Fontware directory.

2. Type FONTWARE at the Fontware 
directory prompt.

3. Select View Control Panel and press 
Enter.

4. Select PostScript Com patibles as the 
printer choice and PostScript Outline
as the character set for the 
printer. Press F10.

Note
Do not select PostScript Outline as the
character set for display.

5. When the screen displays Make Fonts 
in the top center, press E$C to return 
to the Main Menu.

6. Select A dd/D elete Typefaces.
Press Enter.
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7. Press F3 and select the typefaces you 
want. Press F10 to copy the fonts to 
the hard drive.

8. Press F10 again. The Make Fonts 
screen will be displayed.

9. To create the printer fonts you want, 
highlight a typeface and press Enter. 
This places a "yes" next to the 
typeface name.

10. To create screen fonts, press F2. In 
the Display screen, enter the point 
sizes of the display fonts you want to 
create. Press F10. (The font files 
created will have a .PFA extension.)

11. Before you can use the fonts, you will 
need to merge the new width table 
with your present width table. To 
merge the width tables follow the 
instructions on page 4-4 of the 
Bitstream Fontware Installation Kit User 
Guidefor Ventura.

12. To select outline fonts in Ventura, 
follow the usual procedure for 
selecting fonts.
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WordPerfect 5.0

Installing
driver

To use PacificPage P*E with WordPerfect 5.0 
you must install a printer driver and select a 
PostScript printer as your output device. 
Follow the steps below to install the correct 
printer driver and select a PostScript printer:

1. Enter your WordPerfect program and 
insert your WordPerfect Printer Dis­
kette #2 into drive A.

2. While holding down the Shift key, 
press F7 to display the Print menu.

3. Type S (Select Printer).

4. Type 2 (Additional Printer).

5. Type 2 (Other Disk).

6. At the Directory for printer files: type 
A: and press Enter.

7. Use the down arrow key to highlight 
Apple LaserWriter Plu$/IINT/IINTX 
(or Apple LaserWriter Plus on some 
older versions of WordPerfect 5.0). 
Press 1 (Select).

8. Press Enter to install the printer 
driver and update fonts. A Printer 
Helps and Hints screen will be dis­
played.

9. Press F7 (Exit).

10. The Select Printer: Edit menu will be 
displayed. Verify that all information 
is correct and that the correct printer 
port is selected (the default is LPT1).
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11. Press F7 (Exit). The Print: Select 
Printer menu will be displayed.

12. Use the down arrow key to highlight 
Apple LaserWriter Plu$/IINT/IINTX 
(or Apple LaserWriter Plus on some 
older versions of WordPerfect 5.0). 
Press 1 (Select).

13. Press F7 (Exit) to return to the 
document level.

Printing a  
PostScript 
docum ent

If you are printing a WordPerfect document 
that was previously formatted for PCL output, 
you must replace all PCL font codes with their 
PostScript equivalent typeface codes. To do 
this, first ensure that the Apple LaserWriter 
Plus/IINT/IINTX is the selected printer. Next, 
press Alt-F3 (reveal codes), then delete each 
PCL font code from the document. Reselect the 
fonts you want to use in your document, then 
follow the steps below:

1. Press Shift-F7 (Print).

2. Verify that the Apple LaserWriter 
Plus /  IINT /  IINTX is the selected 
printer.

3. Set print options (pages, number of 
copies, etc.).

4. Press 1 to print the full document or 
2 to print the current page.

Resetting
printer
tim eout
param eters

If the printer is taking a very long time to 
process data from a large or complex PostScript 
file, WordPerfect will automatically display a 
"Printer not Responding - retry or abort" 
message on the screen. If this happens often.
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Installing 
outline fonts 
(optional)

you should  reset the p rin te r tim eout 
parameters using the DOS infinite retry mode 
command. Enter the following command from 
the DOS prompt.

For parallel interface:
MODE LPTl:,,Pandpress Enter

For serial interface:
MODE COM 1:96,N,8,1 ,P and press Enter

The "96" in the command above indicates the 
default baud rate of 9600. If your computer and 
printer are configured for a different baud rate, 
replace "96" with that number.

Note
When creating tables using proportional 
fonts in WordPerfect, you must use tabs, 
not spaces between text. Also, fixed pitch 
fonts such as Courier must be used for 
line draw functions in WordPerfect.

Refer to your WordPerfect Reference Manual for 
information on creating special PostScript 
effects using WordPerfect.

If you need additional fonts to supplement the 
fonts provided in the cartridge, you may install 
downloadable outline fonts. The following 
pages provide instructions for installing Adobe 
Type 1 and Bitstream downloadable outline 
fonts for use with your PacificPage P*E 
cartridge.
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To install Bitstream's non-QEM soft 
fonts, follow the instructions in the 
B itstream  Insta lla tion  Kit for 
WordPerfect 5.0.

Note

Adobe 
Type 1
downloadable 
outline font 
installation

To install the Adobe Type 1 fonts you must first 
obtain the Adobe Font Installation Program for 
WordPerfect 5.0 from your software retailer. 
You must also obtain the WPRlNT6.ALL file 
for 5.0 from WordPerfect Corporation. To 
install Adobe Type 1 outline fonts for use with 
WordPerfect 5.0 and your PadficPage P*E 
cartridge, refer to your Adobe Type Library 
User's Manual.

Bitstream 
Fontware 
downloadable 
outline font 
installation

To install Bitstream Fontware outline fonts for 
use with WordPerfect5.0 and your PacificPage 
P*E cartridge, follow the steps below. This 
procedure assumes that you have previously 
installed Bitstream Fontware for use with 
WordPerfect. Before instaUing outUne fonts for 
the QEM printer, be sure you have set up 
Fontware for the Alternative PostScript PDL 
printer (QEM), and then choose the PostScript 
(Additional) printer in the Fontware Control 
Panel.

For QEM (Enhanced) font descriptions, a 
maximum download of 4 fonts is suggested if 
your printer has 2 megabytes of additional 
memory. A maximum of 8 fonts may be 
downloaded ifyour printer has 4 megabytes of 
additional memory. Be sure to increase the font 
resource quantity (located in the Cartridge and 
Font menu) to accommodate font descriptions: 
allow approximately 434K with 2 megabytes 
and 868K with 4 megabytes.
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Changing 
the soft font 
format type

To generate downloadable fonts for QEM 
devices with WordPerfect 5.0 and combine 
them  w ith  the 35 residen t fonts of 
the PacificPage P*E cartridge and Adobe 
Type 1 font descriptions, you must modify the 
WordPerfect WPRINT6.ALL file. You may 
obtain the WPRINT6.ALL file for WordPerfect 
5.0 from WordPerfect Corporation.

You also need the PTR.EXE file (dated 11/89 or 
later), also obtainable from W ordPerfect 
C orporation. You may combine Adobe, 
Bitstream, and PacificPage P • E cartridge fonts 
using the following procedure.

1. Using DOS, copy the 
WPPRINT6.ALL file to your Word­
Perfect directory. For example:

COPY A:WPRINT6.ALL C:\WP50

2. At the CAWP50> prompt, type PTR 
WPRINT6.ALL and press Enter.

3. Highlight PostScript (Additional) 
and press Enter.

4. HighUght Soft Font Format Type 
and press Enter.

5. HighhghtAlternativePostScript 
D evice (QEM) or Alternative Post­
Script D evice (Clone) and mark it 
with an * (asterisk).

6. Press F7 three times.

7. Press Y to save the file. Press Enter at 
the File to be Saved prompt.

8. Press Y to replace.

9. Press Y to exit the printer program.
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Selecting the 
PostScript 
(Additional) 
printer

Combining 
outline fonts 
in the same 
docum ent

To select the PostScript (Additional) Printer, 
follow these instructions:

1. Enter your WordPerfect program.

2. Press Shift-F7 to display the Print 
menu.

3. Press S Select Printer.

4. Press 2 Additional Printers.

5. Highhght PostScript Additional) and
press 1 to select it.

To combine Adobe Type 1 fonts. Bitstream 
Outline Fonts, and PacificPage P mE cartridge 
fonts in the same document, follow these 
instructions:

1. Use the DOS copy command to place 
all of the font description files into 
one directory (if they are not already 
there).

2. Enter your WordPerfect program and 
press Shift-F7 to display the Select 
Printer menu.

3. Press S Select Printer.

4. Press3Edit.

5. Press 6 Path for Downloadable Fonts.

6. Enter the path where the files reside.

7. Select fonts and print your document 
following the steps in "Printing a 
PostScript Document" in this chapter.
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WordPerfect 5.1

Installing the 
driver

To use PacificPage P mE with WordPerfect 5.1 
you must install a printer driver and select a 
PostScript printer as your output device. 
Follow the steps below to install the correct 
printer driver and select a PostScript printer:

1. Enter the WordPerfect Install pro­
gram. Select Apple LaserWriter 
IINTX according to the instructions 
given in the Install program menus.

2. Enter your WordPerfect program. 
While holding down the Shift key, 
press F7 to display the Print menu.

3. Type S (Select Printer).

4. Type 2 (Additional Printer).

5. Use the down arrow key to highlight 
the Apple LaserWriter IINTX and 
press 1 (Select).

6. Press Enter to install the printer 
driver and update fonts. A Printer 
Helps and Hints screen will be dis­
played.

7. Press F7 (Exit).

8. The Select Printer: Edit menu will be 
displayed. Verify that all information 
is correct and that the correct printer 
port is selected (the default is LPT1).

9. Press F7 (Exit). The Print: Select 
Printer menu will be displayed.
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Printing a  
PostScript 
docum ent

Resetting
printer
tim eout
param eters

10. Use the down arrow key to highlight 
the Apple LaserWriter IINTX and 
press 1 (Select).

11. Press F7 (Exit) to return to the docu­
ment level.

If you are printing a WordPerfect document 
that was previously formatted for PCL output, 
you must replace all PCL font codes with their 
PostScript equivalent typeface codes. To do 
this, first ensure that the Apple LaserWriter 
IINTX is the selected printer. Next, press Alt-F3 
(reveal codes), then delete each PCL font code 
from the document. Reselect the fonts you 
want to use in your document, then follow the 
steps below:

1. PressShift-F7(Print).

2. Verify that the Apple LaserWriter 
IINTX is the selected printer.

3. Set print options (pages, number of 
copies, etc.).

4. Press 1 to print the full document or 
2 to print the current page.

If the printer is taking a very long time to 
process data from a large or complex PostScript 
file, WordPerfect will automatically display a 
"Printer not Responding - retry or abort" 
message on the screen. If this happens often, 
you should  reset the p rin te r tim eout 
parameters using the DOS infinite retry mode 
command. Enter the following command from 
the DOS prompt:

For parallel interface:
MODE LPTl:,,Pandpress Enter
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Installing 
outline fonts 
(optional)

For serial interface:
MODE COMl:96,N,8,1 ,P and press Enter

The "96" in the command above indicates the 
default baud rate of 9600. If your computer and 
printer are configured for a different baud rate, 
replace "96" with that number.

Note
When creating tables using proportional 
fonts in WordPerfect, you must use tabs, 
not spaces between text. Also, fixed pitch 
fonts such as Courier must be used for 
line draw functions in WordPerfect.

Refer to your WordPerfect Reference Manual for 
information on creating special PostScript 
effects using WordPerfect.

If you need additional fonts to supplement the 
fonts provided in the cartridge, you may install 
downloadable outline fonts. The following 
pages provide instructions for installing 
Bitstream and Adobe Type 1 downloadable 
outline fonts for use with your PacificPage 
P*E cartridge.

Application Setupand Printing Guide 21



Bitstream 
Fontware 
downloadable 
outline font 
installation

Use the fo llow ing procedure  to insta ll 
Bitstream Fontware outline fonts for use with 
WordPerfect 5.1 and your PacificPageP*E 
cartridge. This procedure assumes that you 
have previously installed Bitstream Fontware 
for use with WordPerfect. Before installing 
outline fonts for the QEM printer, be sure you 
have set up Fontware for the Alternative 
PostScript PDL printer (QEM), and then choose 
the PostScript (Additional) printer in the 
Fontware Control Panel as shown in the 
procedure below.

For QEM (Enhanced) font descriptions, a 
maximum download of 4 fonts is suggested if 
your printer has 2 megabytes of additional 
memory. A maximum of 8 fonts may be 
downloaded if your printer has 4 megabytes of 
additional memory. Be sure to increase the font 
resource quantity (located in the Cartridge and 
Font menu) to accommodate font descriptions: 
allow approximately 434K with 2 megabytes 
and 868K with 4 megabytes.

To generate downloadable fonts for QEM 
devices with WordPerfect 5.1 and combine 
them  w ith  the 35 residen t fonts of 
thePacificPage P*E cartridge and Adobe 
Type 1 font descriptions, you must modify the 
W ordPerfect W PPS50.ALL file. The 
WPPS50.ALL file is located on Printer disks 9 
and 10 w hich you m ay obtain  from  
WordPerfect Corporation (selecting PostScript 
(Additional) during installation will create the 
WPPS50.ALLfile).
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Installing 
Bitstream 
Fontware 3.0

Installing 
Bitstream fonts 
forQEM

The procedure for installing Bitstream fonts for 
QEM is provided below. The procedure for 
installing  Bitstream  fonts for non-QEM 
immediately follows.

To install B itstream  fonts for QEM for 
WordPerfect 5.1:

1. In the EK3S WordPerfect subdirec­
tory, type PTR and press Enter. This 
wUl access the PTR program.

2. Press $hift-F 10 and then F5. A list of 
.ALL files will appear.

3. Select WPPSl.ALL (Apple Laser­
Writer II NT) or WPPS50.ALL 
(PostScript Additional).

4. Select Apple LaserWriter lINT.

5. SelectSoftfontform attype.

6. Select Alternative PostScript PDL 
Printer (QEM). Type Y (Yes) to select 
the current.

7. Press F7 twice.

8. Select 3. Rename your printer by 
typing (your nam e) (QEM) printer.

9. Press F7 and Y (Yes) to save the file. 
Type the appropriate path for the file. 
For example:

C:\W P51\(your name).ALL

10. Select Y (Yes) to exit the PTR pro­
gram.
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11. At the DOS WordPerfect directory 
prompt, type:

REN WPPSl.ALL WPPSl.OLD
or
REN WPPS50.ALL WPPS50.OLD

(either file will work)

12. Place the Fontware installation disk 
into drive A and type A: to change to 
drive A. (Substitute the appropriate 
drive letter if you use another floppy 
disk drive.)

13. Type FONTWARE.

14. Follow the prompts to re-install your 
Fontware (you must re-install to be 
able to access the QEM fonts). When 
asked for your printer selection, 
select Alternative PostScript PDL 
printer (QEM) and any other printers 
you need to use.

The Fontware setup control panel 
should look like this:

Directoriesfor |

.ALL File : C:WP51
Printer fonts : C:\QEMFONTS

__ Printer_________________________________

Model (your name) QEM printer
Character set : PostScript

Your font file wiU be built. The fonts 
will pass through five phases as 
shown by the messages on the screen. 
If only four phases are displayed, you 
have installed Fontware incorrectly 
and must re-instaU.
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15. Enter the WordPerfect program to in­
stall your soft fonts. For further 
information, refer to your Bitstream 
Fontware 3.0 Installation Kit User 
Guide.

16. Press Shift-F7 and S (Select).

17. Press 2 (Additional Printers).

18. Select (your nam e) (QEM) printer
and your Printer file name:
_______.PRS and press Enter. The
message "Updating files" will appear.

19. Press F7 (Exit).

20. Select 6 (Path for downloadable 
fonts).

21. Type C:\QEMFONTS and press Enter.

22. Select 4 (Cartridges and fonts).

23. Select Soft Fonts.

24. Mark the fonts you need.

When marking fonts you can use the 
+ (plus) or the * (asterisk). The + 
means that the font will be down­
loaded automatically each time you 
print a document.

The * means that you must download 
the font to the printer memory each 
time you print a document using the 
font (at the document level press 
$hift-F7 and S to select and then type 
7 to initialize the printer).
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Installing
non-QEM
Bitstream
fonts

To configure your Fontware control panel for 
use with non-QEM fonts, set all selections as 
shown in the following illustration:

D irecto ries fo r I

.ALL File : C:WP51

Printer fonts : C:\FONTS

__ Printer___________________________________

M ode l A p p le  LaserWriter___

C h a ra c te r set : PostScript

Note
The Apple LaserWriter_ printer can be 
either the Plus, IINT, or IINTX.

Use the following procedure to build your 
fonts.

1. Enter your WordPerfect program and 
press Shift-F7 to display the Select 
Printer menu.

2. Press S Select Printer.

3. Press 7 Update.

4. Press Enter to continue.

5. Press 6 Path for Downloadable Fonts 
and Printer Command Files.

6. At the cursor, enter the path where 
the files reside. For example:
C:\fonts 7

7. Press 4 Cartridges and Fonts.
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8. Select the soft fonts by highlighting 
the desired soft font and pressing 
Enter.

Combining
fonts

When marking fonts you can use the 
+ (plus) or the * (asterisk). The + 
means that the font will be 
down-loaded automatically each time 
you print a document.

The * means that you must download 
the font to the printer memory each 
time you print a document using the 
font (at the document level press 
Shift-F7 and S to select and then type 
7 to initialize the printer).

9. Press F7 two times to return to the 
document level.

You may combine Adobe, Bitstream, and 
PacificPage P 2 3 4 5 6 7 * 9E cartridge fonts using the 
following procedure.

1. Use the DOS copy command to place 
all of the font description files into 
one directory (if they are not already 
there).

2. Enter your WordPerfect program and 
press Shift-F7 to display the Select 
Printer menu.

3. Press S Select Printer.

4. Press 3 Edit.

5. Press 6 Path for Downloadable Fonts.

6. Enter the path where the files reside.

7. Select fonts and print your document
following the steps in "Printing a
PostScript Document."
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Changing
the$oftfont
form attype

1. Install the PostScript (Additional) file 
according to the instructions accom- 
panyingthe WordPerfect 9 and 10 
printer diskettes. Selecting PostScript 
(Additional) will create the 
WPPS50.ALL file.

2. At the C:\WP51 prompt, type PTR 
WPPS50.ALL and press Enter.

3. Highlight PostScript (Additional) 
and press Enter.

4. Highlight Soft Font Format Type 
and press Enter.

5. HighlightAlternativePostScript 
D evice (QEM) or Alternative Post­
Script D evice (Clone) and mark it 
with an * (asterisk).

6. Press F7 three times.

7. Press Y to save the file. Press Enter at 
the File to be Saved prompt.

8. Press Y to replace.

9. Press Y to exit the printer program.
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Adobe Type 1 
downloadable 
outline font 
installation

To install the Adobe Type 1 fonts you must first 
obtain the Adobe Font Installation Program for 
WordPerfect 5.1 from your software retailer. 
For further information on installing Adobe 
Type 1 outline fonts for use with WordPerfect 
5.1 and your PacificPage P*E cartridge, refer 
to your Adobe Type Library User's Manual

Caution
To allow downloading of Adobe Type 1 
printer fonts to a parallel interface you 
must use the PCSEND Downloader file. 
(The PCSEND file must be larger than 
35,000 bytes.) This file may be obtained 
from Adobe Systems Incorporated. You 
can call Adobe at (415) 961-0911. If you 
attempt to download Adobe Type 1 
printer fonts without this file, you will 
temporarily disable your printer.

You must also obtain the WPPS50.ALL file for 
W ordPerfect 5.1 from  W ordPerfect 
C orporation. The W PPS50.ALL file for 
WordPerfect 5.1 is located on WordPerfect 
printer disks 9 and 10. Install these files 
according to the directions accompanying the 
diskettes.

To install Adobe Type 1 fonts for WordPerfect, 
follow the procedure below.

1. Insert the Adobe installation diskette 
into drive A and change to drive A 
by typing A: and pressing Enter. (Sub­
stitute the appropriate drive letter if 
you use another floppy disk drive.)
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2. Type Install. Press Enter.

3. Select 1. Select WordPerfect and 
press Enter.

4. Press D (Do application). Press Enter.

5. Select Y (Font downloader).

6. Select Y (PSDOWN.EXE).

7. Select Y (PCSEND.EXE). Press Enter. 
Select yes twice.

8. Select the fonts you want by pressing 
Enter and then D (Do fonts). Insert 
the diskette requested.

9. Enter the WordPerfect program.

10. Press Shift-F7. Press S (Select).

11. SelectPostScript(Addltional 
Printer). If you do not have this 
printer file, contact WordPerfect to 
order it.

12. Press 3 (Edit).

13. Select 6 (Path for downloadable 
fonts).

14. TypeC:XPSFONTS andpressEnter.

15. Select 4 (Cartridges and Fonts).

16. SelectSoftfonts.
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17. Select the font number and then the 
font.

When marking fonts you can use the 
+ (plus) or the * (asterisk). The + 
means that the font will be 
down-loaded automatically each time 
you print a document.

The * means that you must download 
the font to the printer memory each 
time you print a document using the 
font (at the document level press 
Shift-F7 and S to select and then type 
7 to initialize the printer).
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Selecting the 
PostScript 
(Additional) 
printer

Combining 
outline fonts 
in the some 
document

To select the PostScript (Additional) Printer, 
follow these instructions:

1. Enter your WordPerfect program.

2. Press Shift-F7 to display the Print 
menu.

3. Press S Select Printer.

4. Press 2 Additional Printers.

5. HighUght PostScript Additional) and
press 1 to select it.

To combine Adobe Type 1 fonts. Bitstream 
Outline Fonts, and PacificPage P*E cartridge 
fonts in the same document, follow these 
instructions:

1. Use the DOS copy command to place 
all of the font description files into 
one directory (if they are not already 
there).

2. Enter your WordPerfect program and 
press Shift-F7 to display the Select 
Printer menu.

3. Press S Select Printer.

4. Press 3 Edit.

5. Press 6 Path for Downloadable Fonts.

6. Enter the path where the font 
description files reside.

7. Select fonts and print your document 
following the steps in "Printing a 
PostScript document."
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Microsoft Word 5.0

Installing the  To use PacificPage P*E with Word 5.0 you will
driver need to install a printer driver and select a

PostScript printer as your output device. 
Follow the steps below to install the correct 
printer driver and select a PostScript printer:

1. Insert the Microsoft Word Utilities 1 
diskette into drive A.

2. From the DOS prompt type: A:SETUP 
and press Enter.

3. When the first screen is displayed, 
press Enter once more and then type 
the appropriate letter for your type of 
disk drive (H for hard drive or N for 
network).

4. Identify the directory where your 
Word program is stored.

5. Verify that the selected drive and 
directory are correct and press C 
(Continue).

6. At the Setup Menu press P (Copy 
printer support to hard disk). 7 8 9

7. Press 5 to select the Apple Laser­
Writer Plus, and press Enter.

8. Press F (Finish printer installation).

9. Insert the Word Utilities/Printers 
disk in drive A and press Enter.
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10. Press Enter to continue.

11. Press Q (Finish and Quit Setup). 
Press Q again (Quit Setup).

Printing a  
PostScript 
docum ent

If you are printing a Word document that was 
previously formatted for PCL output, you 
must replace all PCL font codes with their 
PostScript equivalent typeface codes.

1. Load the document you want to for­
mat (E$c,Transfer, Load).

2. Press E$c, Print, Options.

3. Use the arrow keys to highlight 
PRINT OPTIONS printer: and press F1 
to display a list of printers.

4. Use the down arrow key to highlight 
POSTSCRP and press F1 to select it. 
Press Enter to return to the document 
level.

5. Press Shift-F 10 (to highlight the entire 
document), or press F6 and use the 
arrow keys (to highlight selected charac­
ters or text).

6. Press Esc, Format, Character.

7. Use arrow keys to highlight font 
name: and press F1 to display a list 
of available fonts. 8 *

8. Use arrow keys to highlight a Pacific-
Page P 9E font and press F1 to select 
it.
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9. Use arrow keys to highlight font $ize: 
and type the point size you want to 
use. Press Enter.

Note
Microsoft Word supports PostScript 
fonts in any even numbered point size 
between 2 and 128 points.

10. To print the document, press Esc, 
Print, Printer.

Resetting
printer
tim eout
param eters

If the printer is taking a very long time to 
process data from a large or complex PostScript 
file. Word will automatically display a "Printer 
not Responding - retry or abort" message on 
the screen. If this happens often, you should 
reset the printer timeout parameters using the 
DOS infinite retry mode command. Enter the 
following command from the DOS prompt.

For parallel interface:
MODE LPTl:,,P and press Enter

For serial interface:
MODE COM 1:96,N,8,1 ,P and press Enter

The "96" in the command above indicates the 
default baud rate of 9600. If your computer and 
printer are configured for a different baud rate, 
replace "96" with that number.
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Note
Due to limitations of the Microsoft Word 
software, you cannot preview PostScript 
graphics files using the Print preView 
function in Microsoft Word.

Bold, proportionally spaced fonts may 
extend beyond the margins of your 
document.

Text may extend beyond the boundary of 
a box or Une drawn with the cursor line 
draw function (CNTL F5) if the font is 
larger than 12 point. For the box or hne to 
print correctly, it must be formatted for 
LineDraw 12.

Refer to your Microsoft Word Reference Manual 
for information on creating special PostScript 
effects using Word.
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Installing If you need additional fonts to supplement the
outline fonts fonts provided in the cartridge, you may instaU 

downloadable outline fonts. To instaU Adobe 
Type 1 outline fonts for use with Microsoft 
Word 5.0, refer to your Adobe Type Library 
User's Manual. To install Bitstream outiine fonts 
for use with Microsoft Word 5.0 and your 
PacificPage P*E cartridge, foUow the steps 
below.

Note
This procedure assumes that you have 
previously installed Bitstream Fontware 
for use with Word 5.0.

1. At the DOS prompt, enter your 
Fontware directory.

2. Type FONTWARE at the Fontware 
directory prompt and press Enter.

3. Select View Control Panel and press 
Enter.

4. Press F7 to change selections.

5. Highlight Printer Model.

6. Select PostScript Interpreter Emula­
tion Printer.

7. HighUght Character Set.

8. SelectPostScript.

9. Press F10 to enter your settings.

10. Press Esc to retum to the Main Menu.

11. Select A dd/D elete Typefaces and 
press Enter.
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12. You must now re-select your 
typefaces so that the PostScript infor­
mation will be loaded for them.

13. W henyouhavefinishedselecting 
typefaces, press F10. The Make Fonts 
screen will be displayed.

14. To create the fonts you want, high­
light a typeface and press Enter. This 
places a "yes" next to the typeface 
name. Press F10.

15. When prompted, name the PRD file. 
Press Enter. (The files generated will 
have a .PSF extension.) After generat­
ing the fonts, Fontware will 
automatically return to DOS.

Selecting the After the fonts have been generated, load the
printer file new printer file into Word (refer to your

Microsoft Word User's Guide for instructions on 
loading printer files). Select the name of your 
new printer file (instead of POSTSCRP) when 
you press F1 to display a list of printers. Select 
fonts in the normal manner.

38 Application Setup and Printing Guide



Microsoft Windows 
2.1x, 3.0

Installing the To use PacificPage P*E with application 
driver  programs running underWindows 2.1/3.0 you

will need to select a PostScript printer as your 
output device. Follow the steps below to select 
a PostScript printer and install the correct 
printer driver:

Windows 2. lx 1. Enter your Windows program and 
select Control.exe to access the Con­
trol Panel. (For Windows Run-Time, 
click on —, located at the extreme top 
left of the screen and then select Con­
trol Panel from the dialog box.)

2. Select Installation from the Control 
Panel Main Menu.

3. Select Add New Printer.

4. Insert the Windows Utilities 2 and 
Fonts Disk into drive A. Select OK.

5. Select PostScript Printer from the list 
of printers. Select Add.

6. Type the drive and directory where 
you would like the driver file copied 
and select Yes.

7. Select Setup from the Control Panel 
Main Menu.

8. Highlight PCL/HP LaserJet and 
change the port selection to None.

9. Highlight the PostScript Printer and 
select the proper port.

Application Setup and Printing Guide 39



Note
You cannot have two printers installed 
on the same port.

10. Select OK to retum to the Control 
Panel Main Menu.

11. Select Setup from the Control Panel 
Main Menu.

12. SelectPrinfer...

13. Highlight PostScript Printer and
select OK.

14. Select Apple LaserWriter lINT/NTX
from the list of PostScript printers.

15. Select Options to define margins, 
tiling, errors, handshaking, and job 
timeout. At this time, you should 
download the header if it has not al­
ready been downloaded. To 
download the header, follow the in­
structions in this chapter under 
Downloading the Header.

16. Select OK twice to return to the Con­
trol Panel Main Menu.
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Winck>w$ 3.0 1. Using a DOS or ASCII editor open 
the WIN.INI file in the Windows 
directory. Most word processors have 
this abiUty. For further information, 
see your application manual.

2. Look for the heading [PrinterPorts] 
and change the end of the command 
line to 45,300. For example:

[PrinterPorts]
PCL /  HP LaserJet=H PPC L,None,45,300 
PostScript Printer=PSC RIPT,N one,45,300 
PostScript
(M icrografx)=M G XPS,LPTl :,45,300

3. Save the WIN.INI file as a DOS or 
ASCII file. Do not save as a word 
processor file since this adds un­
desired commands to the file.

4. Open the icon labeUed "Main."

5. SelectControlPanel.

6. SelectPrinters.

7. SelectAddPrinter.

8. Highlight Apple LaserWriter II 
NT/NTX (PostScript Printer).

9. Selectlnstall.

10. Insert the Windows printer diskette 
into drive A. Identify the appropriate 
drive and directory where you would 
like the driver file copied. Click OK.

11. SelectConflgure.

12. Select the appropriate port.
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13. Change the Printer Timeouts to the 
following settings:

Device Not Selected: 45 
Transmission Retry: 300

14. SelectSetup.

15. CHck on the down arrow for Printer 
Selection.

16. Select Apple LaserWriter II NTX.
(You may need to click on the up 
arrow to find it.) At this time, you 
should download the header if it has 
not already been downloaded. To 
download the header, follow the in­
structions in this chapter under 
Downloading the Header.

17. Click OK.

18. Exit the printer control panel.

Print as usual making sure all other settings 
and baud rate (if applicable) are correct. These 
settings are made through the Port option. See 
your User's Guide for the correct settings.
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Note

Downloading 
the header

Autom atically 
downloading 
the header

If you want to use Windows 3.0 with an 
application that is not yet fully supported 
for W indow s, en ter the W indows 
program  using the com m and 
WINDOWS/R at the DOS prompt. For 
instance. If you have installed Windows 
in a directory named WINDOWS on your 
C: drive, you would type the following 
bolded commands at the C: prompt:

C:X>CD WINDOWS
C : \  Wl N DOWS>WI N DOWS/R

The /R  command will allow you to print 
using the cartridge.

A PostScript header must be downloaded 
before you print from a Window's application. 
You may choose to have the header 
automatically downloaded with each print job 
(recom m ended) or you may m anually 
download the header each time you start your 
W indow 's application. The following 
instructions apply to all applications running 
under a Window's environment.

1. Select Setup from the Control Panel 
Main Menu.

2. Select Printer.. .

3. Highlight PostScript Printer 
(appropriate port) and select OK.

4. Select Options.

5. At the Header: prompt, select
Download ea ch  job.

6. Select OK twice to return to the 
Control Panel Main Menu.
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Manually 
downloading 
the header

1. Select Setup from the Control Panel 
Main Menu.

2. Select Printer.. .

3. Highlight PostScript Printer and
select OK.

4. Select Apple LaserWriter lINT/NTX
from the list of PostScript printers.

5. SelectOptions.

6. Select H eader.. .

7. SelectPrinter.

8. Select OK.

9. At the Header: prompt, select Al­
ready dow nloaded.

10. Select OK twice to retum to the Con­
trol Panel Main Menu.

Resetting
printer
tim eout
param eters

Because large or complex PostScript files can 
take a long time to process, you should reset the 
printer's timeout option for the following 
settings:

1. Select Setup from the Control Panel 
Main Menu.

2. SelectPrinter...

3. At the Printer Timeouts (seconds) op­
tion box, change the D evice not 
se lec ted  option to 45 seconds.

4. Change the Transmission Retry op­
tion to 300 seconds.
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Note
If you later experience problems with 
these settings, you can maximize the 
settings to:

Device Not Selected: 99 
Transmission Retry: 999

5. Select OK. Select OK again when the 
Printer Selection Menu reappears.

6. Select Exit from the Control Panel 
Main Menu.

Handshaking  If you use a serial interface, you must set 
for a  Serial handshaking to the "Hardware" setting.
interface  Follow the procedure below to set

handshaking:

1. Select Setup from the Control Panel 
Main Menu.

2. Select Communications Port...

3. At Port, select COM 1 or COM2.

4. At Handshake, select Hardware. 
Select OK to return to the Control 
Panel Main Menu.

5. Select Setup from the Control Panel 
Main Menu.

6. Select Printer...

7. Highlight PostScript Printer on
COM 1: (or COM2: if appropriate). 
Select OK.

8. At the Printer Specifics Dialog Box, 
select Options.
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9. Select Handshaking...

10. At Set Handshaking to:, select
Hardware.

11. At Permanently alter the printer's 
handshaking?, select OK.
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Installing 
outline fonts 
(optional)

Installing 
Adobe Type 1 
fonts

If you need additional fonts to supplement the 
fonts provided in the cartridge, you may install 
downloadable outiine fonts.

To install Adobe Type 1 fonts for Windows, 
follow the procedure below.

Cautlon
To allow downloading of Adobe Type 1 
printer fonts to a parallel interface you 
must use the PCSEND Downloader file. 
(The PCSEND file must be larger than 
35,000 bytes.) This file may be obtained 
from Adobe Systems Incorporated. You 
can caU Adobe at (415) 961-0911. If you 
attempt to download Adobe Type 1 
printer fonts without this file, you will 
temporarily disable your printer.

1. Insert the Adobe installation diskette 
into drive A and change to drive A 
by typing A: and pressing Enter. (Sub­
stitute the appropriate drive letter if 
you use another floppy disk drive.)

2. Type Install and press Enter.

3. Select 1. Select Windows and press
Enter.

4. Press D (Do application). Press Enter.

5. Select Y (Font downloader).

6. Select Y (PSDOWN.EXE).

7. Select Y (PCSEND.EXE). Press Enter. 
Select yes twice.

8. Press D (Do fonts). Insert the diskette 
requested. The fonts will be written 
into your WIN.INI file.
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9. Enter the Windows program.

10. Enter the WIN.INI file.

Add \fontmme____ .PFB to the end
of every font name. For example:

SOFTFONT l= C  WINDOWS\DLW_.PFM\DLW_.PFB

The number of underscores plus the 
characters in the font name must total 
eight.

11. Save the WIN.INI file. The fonts wiU 
be ready to use when you enter your 
Windows application.

If you want to download the fonts to printer 
m em ory, use Adobe PCSEND.EXE or 
PSDOWN.EXE. Refer to your application 
program reference manual for information on 
creating special PostScript effects with your 
software.
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Installing 
Bitstream  
fonts for QEM  
in Windows

To instaU Bitstream fonts for QEM in Windows, 
make sure you select the Alternative Postscript 
PDL Printer (QEM) and any other printers you 
wish to use during the printer installation 
portion of the Fontware installation program.

To configure your Fontware control panel, set 
all selections as shown in the following 
illustration:

I Directoriesfor I

MS Windows : C :\ your windows directory
Printer fonts

___ Display_
: C:\winfonts

Model
Character set

___ Printer

Ansi Windows

Model : Alternative Postscript PDL (QEM) printer
Character set : Postscript
printer port : ALL

1. Insert the Fontware instaUation dis­
kette into drive A and change to 
drive A by typing A: and pressing 
Enter. (Substitute the appropriate 
drive letter if you use another floppy 
disk drive.)

2. Type FONTWARE and press Enter.

3. FoUow the prompts to re-instaU your 
Fontware (you must re-install to be 
able to access the QEM fonts). When 
asked for your printer selection, 
select Alternative PostScript PDL 
printer (QEM) and any other printers 
you need to use.
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4. Build your fonts. FoUow the instruc­
tions in your Bitstream Fontware 3.0 
Installation Kit User Guide.

The font building process will consist 
of five steps. If only four steps are 
completed, your fonts were instaUed 
incorrectly. Repeat the process.

The fonts will be written into your 
WIN.INI file. They will be ready to 
use when you enter the application.

5. Enter the Windows apphcation and 
select the Apple LaserWriter printer. 
Refer to the '^Windows 2.1x" or "Win­
dows 3.0" section to determine the 
name of the menu to open.

Installing 
Bitstream 
fonts for 
Windows

To install Bitstream fonts for Windows make 
sure you select the Apple LaserWriter (Plus, 
IDSTT, or inSTTX) when you select the printers 
you need during the Fontware installation 
program.

Directoriesfor I

MS Windows 

Printer fonts
__ Display__

: C :\ your windows directory 
: C:\winpsfont

Model
Character set

__ Printer___

Ansi Windows

Model : Apple LaserWriter__

Character set : Postscript

printer port : ALL
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1. Build your fonts. Follow the instruc­
tions in your Bitstream Fontware 3.0 
Installation Kit User Guide.

The fonts will be written into your 
WIN.INI file. They will be ready to 
use when you enter the application.

2. Enter the Windows application and 
select the Apple LaserWriter printer. 
Refer to the "Windows 2.1x" or "Win­
dows 3.0" section to determine the 
name of the menu to open.
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Notes
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Micrografx Designer 2.0

Installing the To use PatificPage P ^E with the Micrografx 
driver Designer application running under Windows

3.0 you will need to select a PostScript printer 
as your output device. Follow the steps below 
to select a PostScript printer and install the 
correct printer driver:

1. Enter your Windows program and 
select Main from the Program 
Manager window.

2. SelectControlPanel.

3. Select Printers from the Control Panel 
window.

4. In the Installed Printers dialog box, 
highlight PostScript (Micrografx) on 
LPT1, Active.

If the command is set "Inactive," click 
on Active in the Status window.

5. Select Configure... from the list of 
Printers window.

6. From the Printers - Configure win­
dow, select LPT1: from the Ports 
dialog box.

7. Set the Timeouts (seconds) to:

DeviceNotSelected: 45 
TransmissionRetry: 300

8. Select Setup... The "PostScript 
Printer on LPT1:" window is dis­
played.
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9. Select the correct Paper Size and 
Orientation for your specific needs.

10. Close aU the windows by dicking OK.

Note
When using Designer with Windows, it 
is recommended that Windows be nm  as 
WIN/R and the Print Manager spooler 
be set ON. Also, use the Micrografx 
Designer PostScript driver.
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Aldus PageMaker

Printing a  
PostScript 
docum ent

FoUow the Microsoft Windows 2.1x, 3.0 setup 
instructions of this guide before printing with 
PageMaker. After the Windows setup is 
complete, foUow the steps below to print a 
PostScript docmnent using PageMaker.

1. Access PageMaker and select Printer 
Setup... from the File menu.

2. Ensure that PostScript printer on the 
correct port is highUghted. Select O p­
tions.

3. At the Header option, select 
Download ea c h  job.

Note
If you are printing to a file, select Header. 
At Send header to:, select File.

4. Select Print... from the File menu.

5. At the Print menu, select options for 
number of copies, coUation, pages, 
etc. Select OK.

6. If you are printing a file that was pre­
viously composed for PCL mode 
output, PageMaker will display 
R ecom pose entire publication for 
PostScriptprinter? SelectOK.
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Installing 
outline fonts

Preliminary
installation

You may incur formatting errors when 
using the "recom pose" feature in 
PageMaker. In this case, reselect the fonts 
in your document using the Type Spec 
option in the Type menu.

Note

If you need additional fonts to supplement the 
fonts provided in the cartridge, you may install 
downloadable outline fonts. To install Adobe 
Type 1 outline fonts for use with PageMaker, 
refer to your Adobe Type Library User's Manual. 
To supplement the fonts provided in the 
PacificPage P*E cartridge with Bitstream 
Fontware Outline fonts, follow the instructions 
below.

Before using the B itstream  Fontw are 
Installation Kit that is bundled with Aldus 
PageMaker 3.0, follow the steps below to make 
the kit PostScript compatible so that it can be 
used with PacificPage P®£.

1. If you have previously installed 
Bitstream Fontware for use with 
Aldus PageMaker, go to step 5. If you 
have not installed Bitstream 
Fontware, proceed with step 2.

2. Install the Fontware package accord­
ing to the procedure in the Fontware 
manual.

3. Add the Courier, Swiss, Dutch, and 
Symbol A Prop typefaces to your 
Fontware package but DO NOT 
make fonts with these typefaces.
These fonts are resident in the 
PacificPage P mE cartridge.

4. Press Ctrl-Q to exit Fontware.
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Installing 
Bitstream 
Fontware 
outline fonts

5. In the DOS Fontware subdirectory, 
type FW_PS_ON. Press Enter. Your 
Fontware installation kit is now Post­
Script compatible.

6. Delete the Courier, Swiss, Dutch, and 
Symbol A Prop typefaces.

To install Bitstream Fontware outline fonts for 
use w ith  Aldus PageM aker 3.0 and the 
PacificPage P mE cartridge, follow the steps 
below.

1. At the DOS prompt, enter your 
Fontware directory.

2. Type FONTWARE at the Fontware 
directory prompt.

3. Select View Control Panel and press 
Enter.

4. Select PostScript interpreter em ula­
tion printer as the printer choice and 
PostScript Standard as the character 
set for the printer. Select the printer 
port. Press F10.

5. Press ESC to return to the Main 
Menu.

6. SelectAdd/DeleteTypeface$.
Press Enter.

7. Press F3 and select the typefaces you 
want. Press F10 to copy the fonts to 
theharddrive.

8. Press F10 again. The Make Fonts 
screen will be displayed.
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9. To create the printer fonts you want, 
highlight a typeface and press Enter. 
This places a "yes" next to the 
typeface name.

10. To create screen fonts, press F2. In the 
Display screen, enter the point sizes 
of the display fonts you want to cre­
ate. Press F10. (The font files created 
will have a .PSF extension.)

11. Press Ctrl-Q to exit Fontware.
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